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Grandes Montagens 2009 
 
 
 
 
 Introdução:  
A SolidWorks tem uma séria preocupação em ajudar você a agilizar o seu trabalho. A melhoria contínua 

no desempenho de grandes montagens e desenhos tem uma ênfase maior em cada lançamento do software. Com 
a adição de novas melhorias e o refinamento de funcionalidades existentes, o SolidWorks 2007 oferece agora um 
desempenho inigualável para grandes montagens e desenhos.  

Sobre o manual:  
Este manual é um guia de práticas recomendadas destinado aos usuários que desejam otimizar seu 

desempenho em grandes montagens e desenhos. Dedique algum tempo para ler sobre todas as técnicas. Nem 
todas as técnicas se aplicarão ao seu ambiente de projeto, portanto, identifique as técnicas que funcionem melhor 
para você. As técnicas indicadas a todos estão marcadas como TOTALMENTE RECOMENDADO. Para obter mais 
detalhes sobre as técnicas, consulte o Manual do Usuário do SolidWorks 2007 On-line ou clique em Ajuda para 
acessá-lo no SolidWorks.  

O que é uma grande montagem?  
• Uma grande montagem é qualquer montagem complexa o suficiente para:  

o Maximizar os recursos do seu sistema  
o Prejudicar a produtividade  

 
Quais são os sinais que indicam problemas com uma grande montagem?  

• Uma grande montagem causará uma degradação do desempenho nas seguintes áreas:  
o Abrir e salvar  
o Reconstruir  
o Criação de desenho  
o Rotação e visualização  
o Posicionamento  

 
Que fatores afetam o desempenho de uma grande montagem?  

• Configurações gerais (Opções)  
• Montagens (Peso leve ou resolvida, posicionamento, configurações, referências externas)  
• Desenhos (Peso leve ou resolvida, configurações, vistas, qualidade da exibição)  
• Peças (Esboços, referências externas em detalhe)  
• Gerenciamento de dados (Gerenciamento de dados manual, PDMWorks)  
• Hardware (CPU, memória, placa de vídeo, SO)  
• Ambiente (Rede, metodologia de recuperação)  
• Próximas etapas  
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Configurações gerais:  
 
Modo de Grande montagem e Montagens em Peso Leve: TOTALMENTE RECOMENDADO  

• Peso leve é uma combinação de configurações de Opções que resultam no desempenho      
    melhorado  
• Inclui uma configuração de opção para acionar montagens Peso leve (consulte “Montagens”   
    abaixo)  
• Um limite baseado em número de peças na montagem pode ser definido para acionar o Modo  
   de Grande montagem  
• Podem ser ativados instantaneamente – Ferramentas (Tools) > Grande montagem (Large    

    Assembly)  
 
 
 

 
 

Para ativar o Modo de Grande montagem:  

Ferramentas (Tools) > Modo de Grande montagem > (Large Assembly Mode)  
• Quando ativado, o Modo de Grande montagem torna algumas configurações de Opções não    
    editáveis (as opções aparecem obscurecidas); quando desativado, as opções voltam ao normal    
    (editáveis).  
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Opções do modo de grandes montagens 

• Você pode alterar o modo de grandes montagens : Ferramentas>opções-Montagens 

• Opções altamente recomendadas são: 
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Opções do Modo de Grande montagem  
• Carregar componentes de peso leve automaticamente  
• Não salvar informações de recuperação automática  
• Ocultar todos os eixos planos, esboços, curvas, anotações, etc.  
• Não exibir arestas no modo sombreado  

 
Desempenho:  
Para aprimorar o desempenho, não exiba arestas no modo sombreado  

• As configurações relacionadas ao desempenho podem ser encontradas em Ferramentas (Tools)   

    > Opções (Options) > Desempenho (Performance)  
• “Sem visualização ao abrir” (No preview during open) permite a abertura mais rápida do  
     modelo, porém não fornece uma visualização – não é controlado pelo Modo de Grande  
     montagem  

 
 
 
Metodologia de projeto: Use quando apropriado 

  

As técnicas de modelamento listadas a baixo são muito poderosas, porém elas tem vantagens e 
desvantagens. Tenha certeza de utilizá-las com cuidado e use-as apenas quando tiver certeza que atenderá sua 
situação  

Projeto  Bottom-up 

Projeto bottom-up é o método tradicional. Faça suas primeiras peças do projeto, então coloque-as em 
uma montagem e utilize os mates para posicionar as peças. Para alterar as peças, você deve editá-las 
individualmente. Essas mudanças são vistas na montagens. 

 
Projeto bottom-up é o método preferido para uma construção prévia off-the-shelf part, 
Ou componentes padrões como parafusos,polias etc.Essas peças não mudam sua forma ou dimensão 

baseados em seus projeto, ao não ser que você utilize outro componente 
 
Projeto Top-down 

Projeto Top-down também pode ser chamado “modelagem no contexto” na ajuda do SolidWorks 
Nos Projetos Top-down a forma das peças, tamanhos, e locais podem ser projetados na montagem.Por 

exemplo: Você pode modelar um suporte de motor então ele sempre vai ter o tamanho correto para segurar um 



 

 

 

CADWorks Tecnologia e Sistemas – Razão Social: CAD 3D Works Importação de Hardware e Software Ltda. 
Tel. 11 4472-8763 – E-mail: cadworks@cadworks.com.br – Site: www.cadworks.com.br 

 

motor mesmo de você mover o motor . O SolidWorks automaticamente altera as dimensões do motor.Esta 
capacidade é particularmente recomendada para peças como suportes e compartimentos, cujo propósito 
principalmente manter outras peças em seus lugares corretos.Você também pode usar o projeto Top-Down em 
certos recursos( como pinos de fixação) ou qualquer outra peça do modo Bottom-Up. 

 
A concepção de fotocópias podem ser definidos em um esquema esboço, cujos elementos representam as 

roldanas, tambores, correias, e outros componentes da fotocopiadora. Você cria os componentes 3D baseado 
neste esboço. Como mover ou redimensionar elementos no esboço, SolidWorks automaticamente se move ou 
redimensiona o 3D componentes na montagem. A velocidade e flexibilidade do esquema permite que você tente 
várias versões do modelo antes de construir qualquer geometria 3D, e para fazer vários tipos de alterações nos 
uma localização central 

A vantagem do projeto top-down é que muito menos retrabalho é necessário quando ocorrem mudanças 
concepção. As peças sabem como se atualizar baseadas na maneira como você as criou. 

 
Você pode usar as técnicas do projeto top-down em certos recursos de uma peça, em peças completas, 

ou montagens inteiras. Na pratica, os projetistas utilizam as técnicas de Top-Down para lay out de suas montagens 
e capturar os aspectos chave para as peças especificas para suas montagens 

 
Técnicas para esboço de layout de montagem 

Você pode projetar uma montagem de cima para baixo usando o layout esboços. Você pode construir um 
ou mais esboços montagem mostrando onde cada componente pertence. Então, você pode criar e modificar o 
projeto antes de criar quaisquer partes. Além disso, você pode usar layout esboços para fazer as alterações na 
montagem  a qualquer momento. 

A grande vantagem de conceber uma montagem usando um layout esboço é que se você alterar o layout 
esboço, a montagem e suas peças são atualizados automaticamente. Você pode fazer alterações rapidamente, e 
em apenas um lugar. 

 
Para utilizar o esboço de layout nas montagens, faça o seguinte: 

• Crie um esboço de layout na montagem onde varias entidades de esboço representam peças na 
montagem.Indicando uma possível localização para cada componente, capturando a intenção de projeto global 

• Referencie a geometria no esboço de layout quando você criar cada componente.Use o esboço de 
layout para definir o tamanho do componente, forma, e localização na montagem, tenha certeza de que cada peça 
tem uma referencia no esboço de layout 

Criando uma peça na montagem 
Você pode criar uma nova peça no contexto de uma montagem. Dessa forma, você pode usar a geometria 

outros componentes da montagem, enquanto projeta a peça. A nova peça é guardada internamente na montagem 
arquivo como um componente virtual. Posteriormente, você pode salvar a peça seu próprio arquivo. 

Também é possível criar uma nova sub-montagem no contexto de uma montagem. Consulte Criando uma 

sub-montagem na Ajuda do SolidWorks para mais informações. 
Para salvar um componente virtual em seu próprio arquivo externo, clique com o botão direito do mouse 

e selecione salvar em arquivo externo. 
Técnica de esqueleto de peça 

Esta técnica é similar a técnica de esboço de layout na montagem exceto pelo esboço ser criado na peça e 
não a nível de montagem. 
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Esta técnica é mais efetiva se você quiser colocar seu esboço de layout diretamente em uma peça ou em 
qualquer montagem como a primeira peça. Graças a essa técnica o esboço de layout pode ser usado tanto para 
peças como para montagens. 

• Crie uma peça que representara todo o layout da montagem – nos chamamos isto de peça 
esqueleto.Na maioria das vezes é um esboço 2D, um tipo de linha de secção atravessando o projeto.Isto pode 
conter esboços, planos, pontos, superfícies, qualquer coisa que for preciso para definir o esqueleto no nível de 
detalhe que você precisa, você pode usar um bloco de esboço para criar de forma mais fácil o esqueleto, e até criar 
um mecanismo móvel para um teste cinemático 

• Esta peça esqueleto pode ser adicionada como a primeira peça de qualquer montagem, ou ser 
inserida diretamente em uma peça.Sub-montagens podem também utilizar a peça esqueleto, porém você terá que 
abrir apenas a sub-montagem, você ainda pode ver e selecionar as referencias da peça esqueleto que representam 
as referencias criticas de toda a montagem. 

• Peças podem adicionadas a peça esqueleto em uma sub-montagem ou em uma montagem de nível   
         superior. 

• Peças esqueleto podem ser filtradas pela BOM, assim elas não aparecem. 
Atenção: Se você criar referencias no contexto com o esqueleto, ou peças unidas de uma mecanismo para 

o esqueleto, Você não poderá movimentar livremente os componentes. A posição do componente será atualizada 
caso o esqueleto mude. 

 

Técnica de Múltiplos corpos 

Se você tem peças na montagem que tem uma relação extremamente estreita com outras peças 
(Cavidade de um molde, por exemplo), você deve considerar utilizar múltiplos corpos. 

Técnicas “Inserir Peças” ou “Modelo Mestre” 

Se você tem um projeto com apenas peças que tenham algumas relações estreitas entre as peças você 
pode optar por modelar apenas a geometria externa ou as referencias ( a capa externa de celular, por exemplo). 

Esta técnica é freqüentemente utilizada na concepção produtos de consumo,carroceria de automóveis, e 
outros modelos com desenho  relacionamento entre as peças e também que exigem uma forma complexa. Esta 
técnica de projeto é mais apropriada se você costuma iniciar seu projeto com um modelo que representa a 
superfície exterior do produto 

 
 
 

 
 
 
 

Montagens:  
Como funcionam as montagens  
• As montagens são resolvidas sucessivamente nesta ordem:  
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Dicas sobre “Posicionamentos” (Mates)  
• Posicionar vários componentes em relação a uma referência comum é melhor que “colocar em cadeia”  
o Exemplo: posicione 3 parafusos em uma chapa plana. Posicione a parte inferior da cabeça na superfície   
    superior da placa em vez de posicionar a parte superior do parafuso B na parte superior do parafuso A,  
    a parte superior do parafuso C na parte superior do parafuso B e assim por diante  
• Desempenho do posicionamento em ordem de velocidade (mais rápido a mais lento):  
o Posicionamentos de relação (Coincidente, Paralelo, etc.)  
o Posicionamentos lógicos (Largura, Came, Engrenagem)  
o Posicionamentos de distância  
o Posicionamentos de limite  
 
Evite referências circulares  
• Ocorre com mais freqüência no posicionamento de recursos em contexto  
• Também pode ocorrer no posicionamento de padrões de componentes  
• Um sintoma comum de referências circulares são montagens que requerem mais de uma reconstrução  

 

Montagens em peso Leve: TOTALMENTE RECOMENDADO  
• Pode-se carregar uma montagem com seus componentes ativos totalmente resolvidos ou peso 
 leve. Tanto peças como sub-montagens podem ter peso leve.  
• Quando um componente é totalmente resolvido, todos os dados do modelo são carregados na  
    memória.  
• Quando um componente é peso leve, somente um subconjunto de dados do modelo é  
    carregado na memória. Os dados restantes do modelo são carregados de acordo com a   
    necessidade.  
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• O Modo de Grande montagem (consulte “Configurações gerais” acima) pode ser configurado 
para que as montagens sejam automaticamente abertas como peso leve se houver mais de um 
determinado número de componentes.  

 

 
Os componentes peso leve são exibidos com um ícone de uma pena no FeatureManager. 

 
Você pode melhorar significativamente o desempenho de grandes montagens usando 

componentes peso leve. Carregar uma montagem com componentes peso leve é mais rápido que carregar 
a mesma montagem com componentes totalmente resolvidos. Montagens com componentes de peso leve 
são reconstruídas mais rapidamente porque menos dados são avaliados.  

Componentes de peso leve são eficientes porque os dados do modelo completo dos componentes 
são carregados somente conforme a necessidade. Somente componentes afetados pelas alterações feitas 
na sessão de edição atual se tornam totalmente resolvidos. Você pode executar as seguintes operações de 
montagem em componentes de peso leve sem resolvê-los:  

 
Adicionar/remover posicionamentos 

 
Detecção de interferência  

Seleção de aresta/face/componente Detecção de colisão  
Recursos da montagem  Anotações  
Medida  Dimensões  
Propriedades da seção  Geometria de referência da 

montagem  
Propriedades de massa  Vistas da seção  
Vistas explodidas  Seleção avançada de 

componentes  
Simulação física  Exibir/ocultar avançado de 

componentes  

 
• Quando um componente está em peso leve uma pena aparece no ícone do componente a arvore de  

• projetos do feature manager  

• Para carregar os componentes automaticamente em peso leve: 
o  Clique em  ferramentas >Opções>Desempenho 
o  Em montagens, selecione carregar componentes automaticamente como peso leve 
o  Se as opções anteriores não tiverem marcadas, você pode abrir manualmente uma montagem com   
          seus  

o componentes em peso leve 
 

Abrir grandes montagens de peso leve: TOTALMENTE RECOMENDADO 
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Você pode abrir uma montagem no modo Peso leve 
 

 
Para abrir manualmente uma montagem com componentes peso-leve:  
o Clique em Arquivo (File), Abrir (Open).  

o       A caixa de diálogo Abrir é aberta.  

o       Selecione Peso leve (Lightweight), procure o arquivo de montagem e clique em Abrir.  

o       Todos os componentes da montagem são carregados como peso leve.  

o       Para definir um ou mais componentes resolvidos como peso leve:  

               Para um único componente, clique com o botão direito no componente e selecione Definir como         

         peso leve.  

o Para uma montagem inteira, clique com o botão direito no ícone de montagem de nível superior e  
   selecione Definir resolvida como Peso leve (Set Resolved to Lightweight).  
o Para uma sub-montagem e seus componentes, clique com o botão direito no ícone de sub-montagem e   
    selecione Definir resolvida como peso leve.  
 
   “Abrir grandes montagens utilizando visualização rápida/ abrir seletivo” permite  
       a você abrir componente específicos de uma montagem não carregando todos os outros 

componentes na memória 
• Os componentes na montagem ainda carregam seus posicionamentos assim os componentes se    
         movem com relação aos outros mesmo que esses componentes não estejam carregados 

• Você pode selecionar componentes para abrir, clicando em um componente individualmente,   
         usando a caixa de clique 2D, ou a “seleção por volume 3D” , em ferramentas>selecionar  

• O ícone “exibir ocultar itens”  encontrado na barra de ferramentas de montagem permite a    
         você ocultar em item apenas selecionando-o  

• Um estado de exibição da montagem, neste estado, pode ser salvo e reutilizado 
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                                          Abre apenas a arvore de projetos 
 
Abrir um estado de exibição de uma montagem: Altamente Recomendado 

• Você pode abrir um estado de exibição de uma montagem e também ocultar componentes ou não    
          carregá-los na memória 

• “Arquivo – Abrir” e selecionar o estado de exibição e habilitar ou desabilitar “Não carregar os   
          componentes ocultos”. 

Usar sub-montagens: TOTALMENTE RECOMENDADO  

• Use sub-montagens – evite estruturas planas com muitos posicionamentos  
     o Em sub-montagens, somente sub-montagens que precisam de atualização serão     
           atualizadas.  
     o Se a montagem for plana e sem sub-montagens, todos os posicionamentos de        
            todas as peças serão atualizados.  

• Se desejar exibir a movimentação de uma sub-montagem, poderá transformá-la em uma  
          Sub-montagem flexível.  

Usar Configurações de montagens onde for apropriado  

•  As configurações de montagens permitem suprimir peças e substituir configurações      
          “simplificadas” de peças por modelos acabados mais complexos  

•  Ao suprimir peças e recursos, mais RAM é liberada  

•  Nota: Use configurações se preferir manter as configurações simplificadas neste nível da 
montagem ou se for por questões de projeto (uma nova configuração de projeto). Não use configurações para 
simplesmente Ocultar/exibir peças, pois as configurações são SEMPRE reconstruídas. Consulte “Estados de 
exibição” abaixo se desejar apenas ocultar e exibir muitas peças com uma seleção.  

•  Ao simplificar peças, verifique se não está suprimindo superfícies que são necessárias nos  
          posicionamentos  
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• Configurações de nível de montagem conferem ao SolidWorks a flexibilidade   
           para controlar:  

o Configurações de nível de peça  

o Supressão de peças  

o Visibilidade da peça  

o Estado de supressão de posicionamentos  

o Modificação de recursos da montagem  

o Supressão de padrões de componente  

o Propriedades específicas da configuração  

o Valores de posicionamentos de distância e ângulo  

• Sempre abra a montagem com a configuração correta ativa para economizar tempo; assim não será 

necessário alternar para a configuração desejada 

        
Usar Estados de exibição onde for apropriado  

• Estados de exibição NUNCA requerem uma reconstrução, Configurações são SEMPRE reconstruídas  

• Nota: Para Ocultar/exibir e visualização avançada, use Estados de exibição; para exibir versões    

   diferentes de um projeto, use Configurações  

• Controles:  

o Visibilidade da peça  

o Modo de exibição  

o Textura  

o Transparência  
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Use isolar 

• Use isolar para ocultar rapidamente todos os componentes  

• Configuração temporária que permite fácil seleção emanipulação do modelo 

 
                          Isolar pode ser usado para ocultar rapidamente todas as peças,  
                                                 exceto aquelas selecionadas 
 
Reparar referências em falta/quebradas  

• Garante a precisão e as velocidades com que a montagem é reconstruída  

Rota elétrica  

• Rota de conector a conector, não de pino a pino  

• Exibe as informações pino-a-pino em uma tabela no desenho de fiação  
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Como trabalhar com grandes configurações  

• Carregue configurações “pesadas” enquanto trabalha em configurações “mais leves”  

• Faça isso tornando inativas configurações pesadas, mas defina Propriedades para    

          aceitar novos componentes, seus posicionamentos etc.  

 
 

Série de furos  
• Use Série de furos (Hole Series) para criar furos em várias peças e adicionar automaticamente    

   pilhas de componentes de fixação (ou seja, parafusos, arruelas, porcas, etc.)  
• Inserir (Insert) > Recurso de montagem (Assembly Feature) > Furo (Hole) > Série de furos (Hole  

   Series)  
• Garante que os furos serão alinhados e os componentes de fixação corretos serão adicionados   

    aos furos  
• Exibição do furo no nível da peça  

• Seleção do componente de fixação baseado no Assistente de Perfuração  

• A BOM será precisa com componentes de fixação corretos  

• Atenção: Cria referência externa porque um ponto de esboço de furo é criado  

Bloquear referências externas  
• O bloqueio de referências externas evita uma reconstrução causada por uma referência externa  
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• Recomendamos decidir se deseja referências externas antecipadamente  

 
 
Você pode decidir antecipadamente se deseja criar referências externas ou não usando a opção 

“Não criar referências externas para o modelo” 
 

 
Referencias externas podem ser visualizadas, bloqueadas e quebradas 
 
Suspender reconstrução automática 
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Suspensão de reconstrução automática 

 
•  Atenção: Use esta opção somente quando absolutamente necessário. Erros de reconstrução     
           criados enquanto esta opção estiver ativa não serão aparentes até que a opção seja desativada (ou que    

          você faça uma reconstrução manual), o que pode dificultar a determinação da causa dos erros  

 
• Para adiar a atualização das montagens:  
o Clique com o botão direito no nome da montagem, no topo da árvore de projeto do Feature   
         Manager, e selecione Suspender reconstrução automática  

o (Reconstrução suspensa) aparece na barra de status  

 
• Para atualizar manualmente quando estiver no modo Suspender reconstrução automática:  
o Clique em Reconstruir na barra de ferramentas Padrão  

• Para desativar a opção:  
o Clique com o botão direito no nome da montagem, no topo da árvore de projeto do Feature 

Manager, e desmarque Suspender reconstrução automática  

• Você precisa redefinir a opção sempre que carregar o documento da montagem  
Desenhos:  
Desenhos peso-leve: TOTALMENTE RECOMENDADO  

•  Desenhos peso-leve são semelhantes a montagens peso-leve. Quando um desenho é peso leve, 
somente um subconjunto de dados do modelo é carregado na memória. Os dados restantes do modelo são 
carregados conforme necessário.  

• O desempenho de desenhos de grandes montagens é melhorado significativamente com desenhos 
peso-leve. Carregar um desenho peso-leve é mais rápido que carregar o mesmo desenho com peças totalmente 
resolvidas.  

• Desenhos de peso leve são eficientes porque os dados do modelo completo são carregados 
somente conforme a necessidade.  

• Para carregar um desenho como peso leve:  
o Ao abrir um desenho, selecione Peso Leve na caixa de diálogo Abrir.  

• Para definir componentes da montagem como peso leve ou resolvido:  



 

 

 

CADWorks Tecnologia e Sistemas – Razão Social: CAD 3D Works Importação de Hardware e Software Ltda. 
Tel. 11 4472-8763 – E-mail: cadworks@cadworks.com.br – Site: www.cadworks.com.br 

 

o Clique com o botão direito em um componente e selecione Definir como Peso leve ou Definir como 
resolvido.  

o Quando um componente é peso leve, uma pena aparece no ícone da peça na árvore de projeto do 
FeatureManager.  

• Para definir vistas de desenho como peso leve ou resolvido:  
o Clique com o botão direito em uma vista de desenho e selecione Definir resolvida como Peso Leve   
         (Set Resolved to Lightweight) ou Definir Peso Leve como resolvida (Set Lightweight to Resolved).  

o Uma pena na árvore de projeto do FeatureManager também indica vistas de peso leve.  

• Desenhos desanexados não podem ser peso-leve.  

• Com desenhos peso-leve você pode:  
o Criar todos os tipos de vistas de desenho  
o Anexar anotações aos modelos nas vistas  
o Dimensionar modelos nas vistas  
o Especificar propriedades da aresta  
o Selecionar arestas e vértices  
o Definir desenhos de sub-montagens como peso leve ou resolvido  

• Se imprimir um desenho peso leve quando estiver fora da sincronização com o modelo, o desenho    
         será impresso com uma marca d’água:  

o Desenho peso leve do SolidWorks – Impressão desatualizada  
           Outras dicas de desenho:  

• Sempre use vistas de Alta qualidade  
o Use vistas sombreadas para desenhos de layout  
           Modifique configurações do sistema para refletir: Ferramentas (Tools) > Opções (Options) > Estilo    
         de exibição (Display Style) > Sombreado (Shaded)  
 

 
Use vistas sombreadas no layout de um desenho (mais rápido) 

 
•         Use configurações para minimizar detalhes desnecessários nos desenhos:  
o         É possível alternar as configurações posteriormente  
•         É melhor usar menos vistas por folha  
o         Em vez disso, use várias folhas ou desenhos  
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•         Atualize somente vistas individuais  
•         Se você usa configurações e ainda pode preservar a numeração de BOM  
o         Se você usa configurações e supressão, é possível manter a numeração . 
 

 
Ao utilizar configurações você pode suprimir ou manter a numeração de BOM 

 
 
 

 
 

 
IMPORTANTE: Tenha cuidado com o uso de configurações, vistas de seção, vistas de               

                           detalhes e vistas de posição alternada  
o Quanto mais configurações um desenho fizer referências, mais tempo será necessário para atualizar    
         o desenho. Cuidado com o número de configurações a que um desenho em particular faz referência  

o O SolidWorks precisa tocar, reconstruir e armazenar na memória cada configuração para manter o    
         desenho atualizado  

• Configurações, seções, detalhes e vistas de posição alternativa são essencialmente “modelos novos”    
         no ambiente de desenho  

 Dica: Tenha cuidado com o número total de folhas  o considere dividir várias folhas   
           em vários arquivos  

•         Verifique se há interferências antes de ativar vistas de desenho HLR  

• a ambigüidade em relação ao que é exibido ou não exibido afeta o tempo de criação da vista de    
         desenho  

 
Peças:  
Técnicas de modelagem  
•        Defina totalmente seus esboços, eles serão resolvidos com mais rapidez  
•        Solucione erros de reconstrução  
•        Não modele roscas, a menos que seja absolutamente necessário!  
o        Use representações de rosca se for necessário para efeito visual  
o        Modele somente roscas funcionais (ou seja, parafuso de Arquimedes, alimentação de parafuso etc.)             
          se for absolutamente necessário. Mesmo assim, suprima-as no nível de montagem superior, se        
          possível  
•        Evite usar texto para recursos; em vez disso, use um esboço ou desenhe letras simplificadas  
•        Minimize os detalhes desnecessários – use entidades de esboço 
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Não crie recursos para detalhes desnecessários 

 
• Use templates diferentes para armazenar Configurações do documento                para componentes   
         específicos 

 
o Acelere a verificação de interferência usando templates para armazenar o “CompFix” (IsFastener), 

que designa o componente como um componente de fixação para verificações de interferência. Isso ignorará a 
interferência criada pelo fato de a rosca ser um cilindro  

 
Definição da propriedade “CompFix” 
 

 
• Filetes  
o Se possível, adicione filetes por último e suprima-os quando não forem mais necessários  
o Combine filetes de mesmo tamanho em um recurso  
• Padrões  
o Evite exibir padrões grandes ou complexos no nível de montagem superior (ou seja, padrão de 

preenchimento)  
o Experimente a opção “Padrão de geometria” (Geometry pattern) ao criar um padrão – é mais rápido 

em regerações  
• Molas  
o Não modele detalhes de mola e evite modelar hélices. Use um cilindro para representar a mola  
• Geometria importada  
o Ao utilizar o FeatureWorks, crie somente recursos em peças se for necessário. Deixe como 

geometria importada se os recursos do SolidWorks não forem necessários  
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o Quando possível, verifique se toda geometria importada está totalmente costurada para criar um 
sólido  

o Modele montagens apropriadas como peças em vez de como montagens (ou seja, rolamentos). 
Você pode usar “Salvar como peça” (Save As Part)  

 
Gerenciamento de dados:  
Por que é importante usar o PDMWorks Workgroup ou Enterprise para trabalhar com grandes 

montagens?  
•       Utilizado com mais freqüência em um ambiente multiusuário  
•        Policiamento de dados  
o Um sistema PDM gerencia quem tem o controle de arquivos para modificação.  
o Evita a sobregravação e a perda de dados  
•        Controle de revisão  
o Controla o nível de revisão de arquivos  
o Conhece o nível de revisão correto de todos os componentes de uma revisão de montagem ou 

desenho em particular  
•        Controla o acesso ao projeto  
•         O PDM sabe quando uma peça foi alterada  
o Mesmo alterações no contexto que você talvez não tenha o costume de selecionar manualmente  
o Um sistema PDM torna uma técnica de projeto de cima para baixo muito mais fácil de ser usada em 

um ambiente de equipe  
o Alterações acidentais são evidenciadas por avisos (ou seja, tentando alterar arquivos somente    
         leitura)  

• Coloca arquivos em sua unidade local para que você possa abri-los localmente. É mais rápido do que     
   executar pela rede se o SolidWorks precisar abrir configurações ou resolver componentes de peso leve  
 
PDMWorks Workgroup vs. PDMWorks Enterprise  
• PDMWorks Workgroup  
o Geralmente até 10 usuários  
o Projetos que requerem compartilhamento de componentes  
o Controle de revisão  
• PDMWorks Enterprise  
o Geralmente mais de 10 usuários  
o Tudo que o PDMWork Workgroup faz e mais:  
• Apto a vários locais  
• UApto a fluxo de trabalho  
 
Outras ferramentas para localizar e gerenciar dados do projeto  
• Pesquisa do SolidWorks  
o Maneira mais fácil de localizar e abrir arquivos  
o Uma única ferramenta para pesquisar em todos os pontos por arquivos, inclusive no PDM  
o Pode pesquisar em metadados (propriedades)  
• Preparar e enviar  
o Arquivo (File) > Preparar e enviar (Pack and Go)  
o Uma ferramenta excelente para organizar seus arquivos e enviar a clientes e fornecedores  
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o Cria um arquivo .zip ou salva em uma nova pasta  
o Salva automaticamente todas as peças, montagens referidas, etc.  
Ferramentas para verificação de dados do projeto  

• Utilitários – Comparar geometria  
o  Permite comparar alterações na geometria e nos recursos da peça com facilidade  
o  Exibe as diferenças graficamente  

• SolidWorks Design Checker  
o  Verifica se os padrões da empresa foram atendidos  
o  Aprender a partir de um desenho existente  
o  Correção automática de verificações  
o  Verificador ortográfico  
o  Verifica se há tamanhos de furo fora do padrão  
o  Automação com o SolidWorks Task Scheduler  
Hardware:  
o  Onde estão localizados os requisitos de hardware para executar o SolidWorks?  
o  Os requisitos de hardware estão listados no Portal do cliente do SolidWorks, em Requisitos do        
          sistema  

 
RAM 
o  O requisito mais importante para lidar com grandes montagens é ter uma memória RAM  suficiente  
o  Se você não tiver o suficiente, os dados de grandes montagens serão transferidos (deslocando    
         RAM para o disco)  

 

o Máquina de 32 bits ou 64 bits?  
o As máquinas com 32 bits possuem um limite de RAM de 2 GB – uma vez excedido, você estará    
         deslocando para o disco, o que é muito mais lento  

o A razão principal para escolher máquinas de 64 bits (e SO de 64 bits) é para ter mais memória  
o As máquinas de 64 bits serão mais rápidas em montagens que excedam o limite de 2 GB de sistemas    
         de 32 bits  

o Para todos os grandes modelos que excedam o limite de 2GB da arquitetura de 32 bits,    
         recomendamos um processador X64 com 6 GB ou mais  

o  

Memória virtual  
o  Recomendamos que a memória virtual tenha 2X a capacidade da RAM  
 

Vários núcleos e várias CPUs  
o  Mais rápido, a menos é claro que você precise da memória  
o  Alguns aspectos do SolidWorks são de tecnologia de multiencadeamento. O processador dual core     
         (núcleo duplo) beneficia-se desse recurso  

o o PhotoWorks  
o o Cosmos  
o o Conversão de arquivo  
o o Remoção de linhas ocultas  
Placa de vídeo  

o  Efetua giro e rotação, zoom e panorâmica  
o  Recomendado: um driver e uma placa gráfica de estação de trabalho OpenGL certificada  
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o  Consulte o Portal do cliente do SolidWorks em Hardware e Gráficos sobre placas certificadas  
o  Dica: Se as suas montagens estão sendo executadas próximo ao limite máximo de RAM disponível,   
          uma placa gráfica de nível inferior seria melhor, pois uma placa de 512Mb mapeará para 512Mb de    

         RAM  

 
Desfragmentação  
o  Execute a desfragmentação de disco regularmente  
o  Não utilize programas de desfragmentação de arquivos do SolidWorks, pois o SolidWorks usa     
         alguns dados removidos por esses utilitários  

 
o Service Packs – mantenha-se atualizado com os service packs  
o Muitos erros podem ser corrigidos em diferentes versões de service packs tanto para o SO quanto    
        para o SolidWorks  

 
Rede 

o  Devem ser todas de 100Mb ou 1Gb e separadas de outro tráfego de rede por um gateway  
Ambiente:  
Local do arquivo: MUITO IMPORTANTE  
o  O fator número 1 de desempenho é onde as peças estão localizadas  
o  Os arquivos devem ser locais para um melhor desempenho  
o  Se for preciso obter peças da rede (geralmente um ambiente multiusuário, onde os dados são   
          compartilhados), então use o PDMWorks  

o O PDMWorks criará uma cópia local do arquivo que pode ser alterada; a vantagem do PDMWorks é   
         que somente as peças alteradas são copiadas  

o Se os arquivos são locais, o SolidWorks precisa apenas ler as definições para a configuração atual da  
         montagem  

o Se as peças estão em um local diferente da unidade local, o arquivo inteiro será copiado para um   
         local temporário (sessão atual somente) antes que as configurações necessárias sejam lidas  

o Rotina de pesquisa de documentos referidos  
o Nota: Quanto mais caminhos de pesquisa o software tiver de atravessar para localizar 

documentos na rede, mais lento será o desempenho geral. Isso é mais evidente na abertura de arquivos, ao 

salvar arquivos, alterar configurações, definir Peso leve como resolvido – qualquer operação que precise acessar 

informações adicionais no disco.  
o Quando o SolidWorks abre um documento referido, ele executa uma pesquisa para localizar o   

        documento. Essa pesquisa pode ocorrer, por exemplo, quando você abre um desenho e a montagem   

                     referida não pode ser localizada, ou quando você resolve um componente de peso leve em uma    

montagem  

o Quando o documento referido é encontrado, o software atualiza o seu caminho no documento pai.   
o Quando o documento pai for salvo, o caminho atualizado também será salvo.  
o A coluna Regras a seguir descreve a rotina de pesquisa utilizada pelo software para localizar um   

         documento referido que está faltando.  

o A coluna Exemplos mostra os caminhos que o software verifica usando o seguinte cenário:  
o A montagem foi salva pela última vez como C:\zz\a1.sldasm. Você move a montagem para 

D:\ss\tt\a1.sldasm.  
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o  A primeira peça na montagem foi salva pela última vez como C:\qq\p1.sldprt. Você não move   

         esta peça.  

o  A segunda peça na montagem foi salva pela última vez como C:\zz\yy\xx\p2.sldprt. Essa peça está   

         faltando, seja porque foi excluída ou renomeada, ou porque houve algum erro no gerenciamento dos    

                      arquivos.  

o  Existem dois caminhos na lista de Pastas da caixa de diálogo Opções de locais de arquivos:   

         D:\aa\bb\ and E:\cc\dd\  

o  Você clica em Arquivo, Abrir para abrir a1.sldasm nesse novo local  
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Arquivo de diário (Journal File)  

• Verifique se o arquivo de diário é local, já que você não vai querer gravar um arquivo de diário   
na rede  
• Você pode definir o local do arquivo de diário em: Ferramentas (Tools) > Opções (Options) > 

Locais de arquivo (File Locations)  
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Backup/Recuperar  

• Para obter um desempenho mais rápido, desative esta opção  
• Se realmente deseja fazer backups, verifique se o local do arquivo de recuperação é local e que a   
   freqüência é apropriada  
 

 

Speed Pack –Totalmente Recomendado 

 

O SpeedPak cria uma configuração simplificada de uma montagem sem perder as referências. Se você 
trabalha com montagens muito grandes e complexas, o uso de uma configuração de SpeedPak pode melhorar 
o desempenho de maneira significativa durante o trabalho na montagem e no seu desenho. 

Nota: As melhoras no desempenho da montagem são mais notáveis em montagens muito grandes e 
complexas. 

Uma configuração de SpeedPak é basicamente um subconjunto de peças e faces de uma montagem. 
Ao contrário das configurações normais, onde é possível simplificar as montagens apenas suprimindo 
componentes, o SpeedPak simplifica sem suprimir. Portanto, você pode substituir uma configuração de 
SpeedPak para a montagem completa em montagens de nível superior sem perder as referências. Como só é 
usado um subconjunto de peças e de faces, o uso da memória é reduzido, o que pode aumentar o 
desempenho de muitas operações 

Quando usar o speed Pack 

Use o SpeedPak quando quiser inserir uma montagem complexa grande em uma montagem de nível 
superior, especialmente se quiser ver toda a montagem do SpeedPak, mas precisar posicionar e dimensionar 
somente para relativamente poucos locais.  

Você também pode usar o SpeedPak para facilitar o compartilhamento de arquivos. As informações 
do SpeedPak são salvas inteiramente no arquivo de montagem. Portanto, ao compartilhar uma montagem, 
você pode enviar apenas o arquivo de montagem. Não é preciso incluir os arquivos de componentes. 

Por exemplo, vamos supor que você projetou uma montagem de motor e precisa enviá-la para a 
equipe de projeto do seu cliente para que eles possam inseri-la no projeto do veículo. 
 

1. Você cria uma configuração de SpeedPak da montagem de motor, incluindo todas as 
faces e os corpos que o seu cliente planeja como referência no modelo do veículo.  

2. Você envia apenas o arquivo de montagem do motor. Não precisa enviar arquivos de 
nenhuma das peças de componente do motor.  

3. Eles inserem o seu arquivo de montagem do motor no arquivo de montagem do veículo 
deles. Eles podem adicionar posicionamentos e dimensões a todas as faces e corpos que você incluiu 
na definição do SpeedPak 
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Speed Pack em desenhos 

Ao dimensionar as configurações de SpeedPak em desenhos, você só pode aplicar dimensões às 
arestas incluídas no SpeedPak, as quais são mostradas em preto. As arestas não incluídas no SpeedPak são 
mostradas em cinza. Quando você imprime o desenho, todas as linhas são impressas em preto, a menos que 
você selecione Cores / escalas de cinza na caixa de diálogo Configuração de página. 

Criar um Speed Pack 

1. Na guia do Configuration Manager, em Configurações, clique com o botão direito do mouse na 
configuração existente e selecione Adicionar SpeedPak.  

2. No PropertyManager:  
a. Selecione as faces e os corpos que você quer que sejam selecionáveis na configuração do 

SpeedPak.  
b. Opcionalmente, selecione Remover imagem fictícia para ocultar todas as outras faces, o que 

melhora o desempenho ainda mais.  

c. Clique em  

Uma configuração de SpeedPak é criada como filho da configuração original. Ela é identificada com no 
ConfigurationManager e _speedpak é anexado ao seu nome. 

Nenhum componente aparece na árvore de projetos do FeatureManager. O ícone da montagem 
no alto da árvore indica que a configuração ativa é uma configuração de SpeedPak. 

Na área de gráficos, quando você move o cursor sobre a montagem, somente as faces e os corpos que 
você selecionou para o SpeedPak são visíveis e selecionáveis na região ao redor do ponteiro. 
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Para maiores informações de como utilizar o speed Pack consulte a ajuda do SolidWorks 

 

 

 

 

Próximas etapas:  

 
Não há substitutos para um bom treinamento. Consulte as suas revendas para saber como 

participar de cursos, que incluem Montagens avançadas, Projetos avançados e PDMWorks. 
 

 
 
 

 


